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Information in this document is subject to change without notice and does not represent a commitment on the part of 
CadLine. The software, which includes the information contained in any databases, described in this document is 
furnished under a license agreement or nondisclosure agreement. The software may be used or copied only in 
accordance with the terms of the agreement. It is against the law to copy the software on any medium except as 
specifically allowed in the license or nondisclosure agreement. The licensee (purchaser) may make one copy of the 
software for the purpose of creating a backup copy. No part of this manual may be reproduced, transmitted, transcribed, or 
translated into any language in any form or by any means, without the express written permission of CadLine. 
 
2018. CadLine. All rights reserved. 
 
In no event shall CadLine be liable for special, indirect or consequential damages in connection with or arising from the 
use of this document or any programs contained herein. 
 
Microsoft, MS, and MS-DOS are registered trademarks and Windows is a trademark of Microsoft Corporation. 
 
ARCHLine.XP® is a trademark of CadLine. 
 
This manual was produced using Microsoft Word and ARCHLine.XP®. 
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ARCHLine.XP 2018 News 

Observing our clients and talking to them in their natural context of using ARCHLine.XP helped us to understand our users 
and their real problems. We established their true needs. Our team focused on solving real design issues for users while 
developing ARCHLine.XP 2018 version. Powerful design tools, and brand new interface with ribbon bar. We provide 
designers with the latest novelties in 2018 version.  
It is up to you, how much you use out of them! - A fraction, or a substantial portion of it? 
 
Influential main novelties: 

 Renewed professional user interface and Start Up dialog 

 New international object libraries: BIMObject, Cadenas, Syncronia 

 New quality of lights, lamps, switches from rendering to documentation  

 Lighting 3D text 

 Designing sweep in every direction in a new way 

 Dynamic drawing comparison. The actual and the previous state of the drawings can be compared anytime  

 Wall styles coordinated by new story level parameters automatically apply to the elements created at different height 

levels – New styles 

 Using a point cloud created by 3D scanner 

 Insulation renovation to walls 

 Reshape a single wall layer  

 Rule for Column-Slab, Wall-Slab intersection 

 Built-in elevation views 

 Wipe-out – New mask command 

 Enhanced printing queue 

 4K monitors – Scaling the interface 

 Problem report 

 

1. User interface developments 

1.1. Renewed professional user interface: 

Ribbon bar 
The ribbon provides the palette of the tools necessary to work with a project. 
The ribbon organizes tools into logical groups. The ribbon is composed of a series of tabs, which are organized into 
panels.  
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As a default the Ribbon bar is switched on.  
 
If you are using ARCHLine 2017 or earlier release and you find the Ribbon very different you can switch to the ‘Classic’ 
Interface (working with Toolbox and toolbars). The traditional ’classic’ menu and toolbar can be accessed from the File – 
Options – User interface panel. 

 

 
 
You can display or hide a Ribbon Bar 

You can increase the drawing area by hiding the Ribbon. When you close the Ribbon bar, only the tabs on the Ribbon will 
remain visible. In the top right corner, click to the arrow icon to hide the Ribbon. When you click on the tabs, the Ribbon 
bar is temporarily displayed and you can choose from the available commands. After clicking on the command, the Ribbon 
automatically vanishes. 

 

To display the Ribbon bar again click on the arrow again now facing down. 

 

 
 

Search between the commands of the Ribbon bar 
According to the text written into the search box a list of commands appear which have the same words in them. Click on 
one element from the list and the chosen command starts. If you hover over one element of the list with your mouse its 
tooltip will appear. (local help) 
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Key tips of the Ribbon bar 

By pressing the Alt button on the keyboard small letters, so called Key Tips appear beside the tabs and commands of the 
Ribbon bar. 

 

 
 
Using these letters after pressing the Alt button the commands of the Ribbon bar can be started. Example: by pressing the 
Alt and B buttons after each other the Building tab opens, then by pressing the W button you can access the Wall menu. 
Here if you press the W button again you can start the Wall command. 

  

 
 

 
 
To close the Key Tips press Alt. 
 
Subcommands 

By clicking on the arrows facing down on the panels of the Ribbon bar the drop-down menus open and you can choose 
from the available commands. 
 
Tooltips (local help) 

If you hover over a command for a few moments a tooltip appears which helps the understanding of the command with 
graphics and description. 
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1.2. Start Up dialog 

The Start Up dialog appears at the start of the program and gives access to different initial operations, highlighted 
projects, recent projects or information available online. 

 

 
 

The upper part of the Start Up dialog contains: 
  

 New project: Creates a new blank project. 
 Open project: Opens the Open project file dialog. 
 Exit: Closes the program. 
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 Search: Search projects 
 First steps video: Online service to help learning the basics. 
 Demo projects: Downloadable example projects. 

 
Highlighted projects 

In this section you can select from the pinned projects. A pinned project remains in the list until we remove it with the 
orange minus ( - ) found in the upper left corner. In this case it moves to the Recent projects section. The Highlighted 
projects list can only contain five projects at maximum. If your list is full you have to remove a project before adding 
another. 

 

  
 
Recent projects 

The list of the recently used files. By clicking on the orange minus icon in the upper left corner the project is removed from 
the list. By clicking on the Star icon found in the upper right corner the project is moved to the Highlighted projects section. 
In the pop-up menu the path of the file, its last modifications and its size appears. 

 
 
Notifications 

The lowest part of the Start Up dialog displays the actual news and information about product update, trial version and 
other important things to know. If there is more notification to be found then they are appearing after one another. If there 
is internet connection available by clicking on the notifications the relevant webpage appears. 
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2. New functions 

2.1. Insulation renovation for walls 

Using this command you can add insulation to external walls. 
After starting this command the program automatically selects the external walls 
To the walls marked by GREEN lines a new insulation layer can be added. By clicking on the green lines walls can be left 
out from the list and their line switch to RED. 
Location of the command: Building – Wall – Edit – Insulation renovation 

 
 

 
 
After that in the appearing dialog the insulation layer order which will be given to the layer order of the selected walls can 
be set. 
  

 

2.2. Luminous Text 

Luminous text is often used for decorative lighting. 
Editing the luminous text is fast and flexible. The luminous text is also appear in 2D and 3D. 
The location of command: Interior – Lighting – Luminous text 

 

 With this command we can quickly and easily place lighting 3D text with any flat surface. 
 Applies to external or indoor lighting, backlight with any colour and brightness. 
 The text can be easily edited. 
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2.2.1. Drawing luminous text 

 Start the Interior – Lighting – Luminous text command. 
 Enter the text in the appearing dialog window. 
 Click on the surface where you place the luminous text on the 2D drawing or the 3D model. 
 Enter the starting point and the direction of the text. 
 Enter the thickness of the luminous text. 
 After drawing, the luminous text property window appears and you can set the properties of luminous text. 

 
 

2.2.2. Fast editing luminous text 

Click on the luminous text. The text appears with blue marker. You can change this blue text by clicking and typing the 
new content and then press Enter. 
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2.2.3. Properties of lighting 3D text 

2.2.3.1. Materials and lighting parameters 

On the "Materials and Lighting" tab, you can specify the brightness and colour of luminous text and turn it on / off them. 

 
 

Enable light 
Activate the "Enable light" option to turn the luminous text on. 

Lighting is enabled on the front only 
The light of the luminous text is only applied onto the front surface, the body part of the text does not emit light. 

Light intensity per meter 
Select from the predefined values or type any value to set dimming of level. 

Dimming level 
You can specify the value for modifying the dimming level. 100% means that it adjusts the same dimming level as the 
original dimming level, while providing a different value to reduce or increase the original dimming level. Select from the 
predefined values or type any value to set dimming level of luminous text. 

Light colour 
You can choose any colours for the luminous text. 
Click the button and choose a colour from the displayed colour palette. 

Material of light 
Three materials can be assigned to the text, the material of the body and the material of the front and back surface. These 
are visible when the luminous text is turned off. 

2.2.3.2. Text parameters 

You can edit the text of the luminous text and the text properties on this panel. The latter is visible when the LED strip is 
off. 

 
 

Extrusion height 
You can set the thickness of the luminous text here. 

Text height 
You can set the text size of the luminous text. 

Text style 
You can set the text style of the luminous text here. 

2.2.3.3. General settings 

You can check and modify the relative height and the representation in 2D of the luminous text. 
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2.3. New parameters can be assigned to lamps 

New parameters added to the description of the lamps. 
 Mounting height from floor: defines the height of mounting 
 Light centre height: If we have spot light source then the value will be exactly its’ height. In case of other type of light 

source then it is a theoretical value which must be given manually. 
 Mounting location: Ceiling, wall, desktop, standing 
 Mounting type: Suspended, fixed on surface 
 Dimmable: Yes/No - Is the lighting dimmable? If not, then the dimming level can’t be adjusted. 
 Wattage: Energy consumption index 
 Luminous flux: Accumulated Lumen value 
 BIM parameters: The above values appear as BIM parameters too. 

 

 



 ARCHLine.XP 2018 New features 14 

 ARCHLine.XP® 

2.4. Lighting plan – Manage lamp elevations 

 
The axis sizes of wall lamps can be dimensioned compared to walls and openings. 
Location of the command: Dimension – Lamps on wall  

 

 

 
 
Managing lamp elevations. 
Location of the command: Dimension – Lamps on wall – Manage elevations 

 
 

 
 

2.5. Recessed spot lamps 

In ARCHLine.XP 2018 you can recess spot lamps into the false ceiling and cut the ceiling around them. This can be set on 
a new tab in the properties dialog of the false ceiling. A profile can be selected based on which the program creates the 
hole in the ceiling. The lamp groups can be turned on and off together and their brightness can be set as one. 
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2.6. Rendering with IES based spot lights 

 
In ARCHLine 2018 the spot light cone linear intensity distribution is replaced with accurate IES light emission. IES light 
emission provides physical photometric data distribution, in other words, it displays realistic light emission pattern. 
 

  
 
Spot lamp with cone linear intensity distribution 

 
Spot lamp with accurate IES light emission - 2018 
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2.7. Wall component bounding 

According to BIM standards the height parameters bound to storey level parameters’ list is expanded with the typical 
height settings used in architecture.  
The following parameters can be assigned to every storey levels: 
 

  
 

Name Parameter name Description 

Finish Floor FF Walking surface height relative to 

level 0 

Top of Structure TS Top height of slab 

Bottom of Structure BS Bottom height of slab 

False Ceiling CE This height should be coordinated 

to the bottom of the false ceiling 

relative to 0 

Ledge LE Boundaries of exterior wall 

components relative to 0 

Floor height FH  

 
It is important to know that when you enter a new level, the height parameters are inherited from the active level to the 
new level. 
 
References to the above level: 
(N+1) FF - Finish Floor  
(N+1) TS - Top of Structure  
(N+1) BS - Bottom of Structure  
(N+1) LE - Ledge 

2.8. Rule for Column-Slab, Wall-Slab intersection 

The wall/column would automatically cut a hole in the slab when there is a clash between the 3D volumes. 
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2.9. Reshaping individual wall layers 

In ARCHLineyou can reshape the wall frontal view with an arbitrary polygon. 
 
In 2018 the same principles of reshaping can be applied to a single wall layer too. 
 

 

2.10. Point clouds 

Point clouds are made with laser scanners to capture building and environment dimensions. 
  
ARCHLine.XP 2018 imports widely known point clod formats to support building survey and in the long-term place any 
particular objects. 
The Point cloud can be displayed in its real size on the 3D model and at the same time it creates its top view on the 2D 
layout.  
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Location of the command: Building – Point cloud – Import 
 
Attach Point cloud to a project 

Point clouds can be attached to a project like other external references (xref).  
During import the factors of the scale can be modified so the Point cloud is modified automatically according to the 
modified scale factor. 
 
Point cloud editing 

By wiping out the parts of the Point cloud that are unnecessary for the design the 3D display can be narrowed to important 
parts.  
 
Modelling in 3D 

Using the dynamic section command a surface of the Point cloud can be set as new work plane.  
After that new walls can be added directly in the 3D window. 
With the 3D Shape tool 3D forms can be drawn directly on the 3D surface which can be edited in 3D. 

 

2.11. Elevations 

The new elevation views enables to create the four main views in one project with one single click. 
Elevation labels in the Project Navigator: North, South, East and West. 
The program automatically places a reference onto the floor plan by clicking one of the labels. 
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Add a new elevation 

 
You can create individual elevation. Click on with right clicking on the word “Elevation” and similarly to the section 
definition draw a line and give the direction. 
In the pop-up dialog menu click on Create new command. 

 
 
Place the new Elevation symbol on the floor plan: 

 

 
 
ARCHLine.XP creates a new elevation view. 
 
 



 ARCHLine.XP 2018 New features 20 

 ARCHLine.XP® 

 
 
Click on the elevation view marker on the floor plan to display the actual geometry that can be modified with the help of the grab 
points. 
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2.12. Dynamic drawing comparison 

The compare drawings function compares the current drawing with a previous phase and displays the graphical changes visually. 
The result is a third drawing which displays the changes between the two phases with the assigned colours. 
Location of the command: Documentation – Drawing comparison – Drawing comparison  

 

 
 

Phase 1 Phase 2 

 

 

Compare drawings Compare versions of the drawings 

 
The result can be actualized with one click with the Update drawing comparison command. 
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2.13. Enhanced printing queue 

Print Queue management has changed and the new workflow is very simple and easy. Pressing the green plus button you can 
choose the next view to insert into the Print queue. 
 

 

2.14. Wipe out – Blank area to mask objects 

Create a polygonal area, called a Wipe out to mask underlying objects with transparent grey colour. 
This area is bound by a frame which can be edited. When printing the objects under the Wipe out object will not be visible on the 
printing. 
Location of the command: Drafting – Polyline – Wipe out 

 

      
 
Wipe out on the layout      When printing the area is left out 
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2.15. New international object libraries: BIMObject, Cadenas, Syncronia 

 
 The BIMObject, Cadenas, Syncronia are object libraries which contains BIM models of products of leading manufacturers. 

The object catalogues above contains ten thousands of elements. From the international object libraries the content can 
be downloaded Revit RFA, SketchUp SKP and 3DS formats and the program creates native ARCHLine.XP elements from 
them. The BIM parameters saved in the RFA format are copied into the created ARCHLine. XP element. 
 
Location of the command: Interior – BIM libraries 
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2.16. New ARCHLine Sketch Mode 

The Sketch Mode allows to edit a selected object in a blank project. After starting this command the selected element is 
broken into its components which can be modified, deleted or a new material can be assigned to them individually. After 
the modifications the components should be saved as a new or replacement object, door or window. After this the Sketch 
Mode should be closed. 
 
The main function of the Sketch Mode is to repair the errors of the objects downloaded from the internet but the objects 
already saved in the Design Center can also be modified in it easily. 
When activating the Sketch Mode the program automatically saves the actual project and puts it into the background. In 
the Sketch Mode only the selected object is visible and editable. To return to the saved project close the Sketch Mode. 
 
Location of the command: Interior – Sketch Mode – Open Sketch Mode 

 

 
 

 
 
After downloading from the BIMObject, Cadenas, Syncronia object libraries the program automatically activates the 
Sketch Mode. The imported elements can be converted into object, door or window keeping the original BIM parameters. 
Use the Interior – Single Object – New object command to save the ARCHLine object and the Interior – Single Object – 
New door or New window command to save new door/window. 
 

2.17. Add floor plan in 3D view 

The command copies the floor plan to the 3D view at the same location as the 3D model. In ARCHLine.XP 2018, you can 
move the floor plan to a more visible location than the model. 
Location of the command: View – Visual Styles – Underlay floor plan on 3D view 
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2.18. Problem report 

You can send a direct feedback about any problem occurred during the use of the software.  
 

 Click on the Help menu in the upper right corner. 
 Click on the Report a problem icon. 

 

  
 

 In the dialog explain you problem, including the steps with which the problem can be repeated. 
 Select whether you want to send more information in the report for example upload the project, give your e-mail address 

or send a screenshot. 
 To send the report click on the Upload button. 
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3. Styles in ARCHLine.XP 2018 

When you create an element in a project with a specific geometry and parameters, you create an instance of the element. 
Each element has a set of properties. You can change the properties freely. These changes apply only to the single 
element in the project. 
 
Styles provide a level of control over elements that are similar in use. Using styles optimize the design process and enable 
to create the documents more efficiently. 
 
When you work with often-used object settings (such as wall or slab height, structure, 2D representation, cover materials 
etc.) styles can be a very useful way to store the settings and recall them later at any time.  
 
Styles can be applied later to existing elements as well. 
Styles can be shared as office standard using the loadable package of styles. 
 

3.1. Working with Styles 

When you select a style, all of the properties in that style are copied to the instances of element created with that style.  

When you start the program the element types are displayed with their default properties as saved in the default style.  
 
Styles are saved in three level. The three levels are Project, My and Factory. Optionally you can work with another level 
called Loadable package of styles. 

Styles in Project 

Styles created and saved in a project are included in this category. Please be aware that these styles are not available in 
other projects. These styles are denoted by blue upside down envelope icon. 

My styles 

Your favourite styles are stored here in order to make those available in every project. My styles are distinguished from 
other categories by a human shape icon. 

Factory (built-in) styles 

Factory (built-in) styles come with the installation of the software. These styles have read only property you cannot change 
them. These built-in styles are represented by orange envelope icon. 
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Preferences 

Project styles has the highest preference, followed by My and Factory. 
If you have two conflicting styles that come from different level, there is a weighting system that determines the priorities in 
order to maintain consistency. Styles in project wins over My styles, and My styles wins over Factory (build-in) styles.  

Loadable Package of Styles 

Typically, the loadable package of styles represents standards that are used within a company or installed as 
ARCHLine.XP extension by third parties. These styles may be represented by their own icon or the default 3 circles icon. 
 
 

 

 

3.2. Using styles in the property dialog 

Click on the style button displaying the current style name on one of the properties dialog box (e.g. wall): 
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When no style is loaded, the word is displayed. 

 
Style dialog box appears on the right where the program lists predefined styles. 
You can do the following operations with styles: 
 

 Create new style  
 Activate style  
 Modify, delete, rename style  

3.2.1. Create new style 

Once you have specified all properties of a given object in the Properties dialog box: 

 

 Click the Style button.  

 Click New, and  

 Enter the name of the new style, and organize in folder and sub folder (optional).  
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!  The new style is saved in the project only. If you would like to make this style available in every project you have to 

relocate it into My styles. 

3.2.2. Activate style 

By activating a style you can recall all the settings stored in it. This makes the workflow smoother and quicker when you 
need to use an object with different settings. You can activate a style when you define the settings of an object. 
You can activate a style In the Properties dialog box 

Properties dialog box 

 Click the Style button to display the list of styles, then  

 Select the desired style from the list and click Activate 
or  

 Double click the style name  

 OK Close the dialog box 

 

You may use this method in setting properties or modifying objects as you work. 

 

3.2.3. Modify, rename, delete style 

You can modify the properties of the current style, and rename or delete the style. 

Modify properties 

 Activate the style you wish to modify.  

 Change the properties you want to modify, then  

 Click Modify.  

 In the message box displayed, click Yes to overwrite the selected set.  

Rename style 

 Choose the desired style from the list.  

 Click Rename.  

 Enter the new name of the style.  

 OK Close the dialog box. 

Delete style 

 Open the Properties dialog box and click the Style button.  

 Choose the desired style from the list.  

 Click Delete.  

 Click Yes to reconfirm and delete the selected style.  
 

!  You can rename or delete styles in this dialog that are located on Project level only. 
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3.3. Managing styles in the Properties toolbar 

 
By clicking with right mouse button on a style, the following commands are available: 
 

 

Activate 

With this command you can activate a style. Then you create the next element in a project with the properties stored in 
that style. 

Sort in categories 

With this command you can rename a style. The name of Factory styles cannot be modified. 

Delete 

With this command you can delete styles. Styles in Factory level cannot be deleted. 

Move to package of styles  

With this command styles can be copied from one level to another. Styles cannot be moved to the Factory level. See the 
next chapter for details. 

Export 

You can export this single style in a file with .set extension. 

Import 

You can import a single style from a file with .set extension. 

3.4. How to relocate styles from Project to My level 

You can relocate the styles from Project to My level in Properties toolbar.  
 

 In Properties select the style you are going to relocate, then right-click to display the pop-up menu. 
 Select Move to package of styles: My command in the menu. The style will be moved then. 
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 The command changes the style’s icon from the envelope to human shape icon. 
The style is available in every project from now on.  

 

 
 

!  Styles cannot be moved to the Factory level. 

3.5. How to exchange Styles one by one to another computer? 

You can exchange your favourite styles (My) one by one to another computer. On the popup menu, select Export to save 
or Import to load. Using these commands one file will contain one Style with .set extension. 

 
. 
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3.6. How to export all the styles stored in the My  

You can share all the styles stored in the My category with the following command:  Options dialog - Open and Save – 
Settings and customizations Import / Export. Click on Edit button. 

 
 

 Select the left button to export My styles. 

 Select the Custom button. 
 

 
 

 Click on the Styles: My checkbox before you click on Next button. 
 

 
 

 Select a file name with .environment extension clicking on the Browser button. Then click on Next button. 
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 Press on Commence button to save the file. 

 
 

!  The method is the same if you are going to export the Loadable package of styles. 

3.7. How to import My styles 

You can import all the styles stored in the My category with the following command:  Options dialog - Open and Save – 
Settings and customizations Import / Export. Click on Edit button. 
 

 
 

 Select the right button to import My styles. 

 Select a file name with .environment extension clicking on the Browser button. Then click on Next button. 
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 Select the Custom button. 

 
 

 Click on the Styles: My checkbox before you click on Next button. 
 

 
 

 Press on Commence button to import the file. 
 

 
 
Remember to restart ARCHLine.XP to validate the new styles. 
 

!  The method is the same if you are going to import the Loadable package of styles. 
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3.8. Operations with loadable package of styles 

Typically, the loadable package of styles represents standards that are used within a company or installed as 
ARCHLine.XP extension by third parties.  
Styles can be shared as office standard using the loadable package of styles. 

Specify  

At first you have to specify the name that represents the loadable package of styles. 
Specify it with the following command:  Options dialog - Open and Save – Loadable package of styles.  
Type the name that represents loadable package of styles. In this manual we use the neutral name as “company”. 
 

 
 
Remember to restart ARCHLine.XP to validate the new styles. 
 

 

Unload  

You can switch off the loadable package of styles by deleting the name and let it empty. 
 

 
 
Remember to restart ARCHLine.XP to validate the new setting. 
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3.9. Importing Objects, Materials, Settings from previous versions 

Import from the previous versions 

 
The Import Wizard allows you to select the previously used (in the previous version of ARCHLine.XP) styles, objects, 
materials, settings and import them into the actual version. 
 

!  The Import Wizard will only display the first time after you install the software. Once you have completed it, you cannot 

run it again when you restart the software. 

 
However Import Wizard can be activated any time if you choose the File menu – Options – Open and Save - Importing 
Objects, Materials, Settings from previous versions command if you skipped the default method at the first run. 
 

 Choose the previous program version (You can choose from the installed program versions on your computer.) 

 Select what you want to import.  

 Styles, Object library contents, materials, etc. will be transferred. 

 

 

3.10. Save current settings  

After downloading and installing ARCHLine.XP starts with the initial factory settings. 
The following settings belong here:  
 

 Layers, 
 Units, 
 Angle measure 
 Rounding off decimals 
 Auto save settings 
 Snap, grid, object snap, cursor, marker settings 
 General text settings as display boundary 
 Printing defaults 

 
You can override the default settings with your current settings if you choose the File menu – Options – Open and Save – 
Save current settings as new default command. 
 
Your new settings are stored as new default settings and after restart it will be available in every new project. 
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3.11. Restore factory default settings  

You can restore  ARCHLine.XP factory default settings by resetting your current settings. 
Choose the File menu – Options – Open and Save – Restore your default to factory settings command. 

 
The following settings belong here:  
 

 Layers, 
 Units, 
 Angle measure 
 Rounding off decimals 
 Auto save settings 
 Snap, grid, object snap, cursor, marker settings 

 

!  Please note: all data listed above will be deleted and the factory default settings are restored. 

 
Your new factory settings are stored as new default settings and after restart it will be available in every new project. 
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3.12. Delete layers from current settings  

You can delete any layers from your current settings with the following way: 
Example:  
1 my layer is a user layer and there is no need to use it anymore. 
 

 Press on Delete layer button as indicated below. 
 

 
 

 The deleted layer is displayed in the layer dialog right side clicking on the Deleted layers entry. 
 

 
 

 Override the current settings with your new current settings. Choose the File menu – Options – Open and Save – Save 
current settings to save the new default. 
 

 
 

 Your new layer settings are stored as new default settings and it will be available in every new project. 
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4. Others 

4.1. Marker developments 

In the case of one line text the text appears blue and by clicking into it, it can be edited like on the plot layout or on the plot 
stamp. The command reduces the editing of texts to one step. 

 

4.2. Marker locations 

In some situations the markers are located too close to each other and the desired one cannot be easily selected – e. g.: 
rotate – move, rotate – size, - both in 2D and 3D. To select the desired command we have to zoom in to the drawing. This 
situation is solved by the optimization of the markers. 
 

 
 

4.3. Tiling layout display with coloured tiles or contour lines 

In the Item settings under the Tiling there is a new checkbox with which the colouring of the 2D tiling layout can be turned 
on and off. When it is turned off the program displays contour lines only without background colour. 
 

 

4.4. Model complexity display in the Design Center 

The complexity of the model is now displayed in the Design Center: Mini, Small, Medium, Large, Very large, Extra large 
(these parameters are based on the number of surfaces the model has). 
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Filter objects by complexity 

 
By clicking on the Design Center settings icon a new command is available in the appearing menu which enables us to list 
the more complex elements. With this information the size of the project can be optimized because the less important 
objects can be recognized (e.g.: small flowers, cologne bottle etc.) and whose omission or replacement can significantly 
reduce the size of the project and the render time. 
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4.5. Enhanced teamwork 

Teamwork allows multiple team members to work on the same project at the same time. 
ARCHLine.XP supports teamwork. This means that project can be subdivided and team members may work on separate 
parts of the very same project. The Project Manager is the Administrator who creates a central model so that team 
members can simultaneously make design changes to a local copy of the central model. 
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4.6. 4K scalable user interface 

In the Options dialog, in the User interface panel four icon sizes can be selected from small to extra large. 

4.7. Plot layout scale 1: 25 

The documentation can be placed to the plot layout in 1:25 scale. 
 

4.8. Relocating the whole work environment 

The environment relocation has new features in ARCHLine.XP 2018. We can save and scan any user data that is 
supported by the program in a single file. Supported data includes the user-generated material library, style library, objects 
created by the user or downloaded from the internet, and all user settings (linetypes, sun settings, views). The command 
is available in the Settings / Open and Save tab under the "Environment Package" button. 
 

 
 

4.8.1. Creating an environment package 

 Start the command. 

 In the Popup window, when you select the "Typical"option, the program collects all the user data into a single file. If you 
want to filter more precisely, you have to select the "Custom"option. 

 By clicking on one object or on a category, you can save all the objects and materials in it to one environment package. In 
this case, you need to look up the Object orTexture you want to export from the Design Center, and click on the Cogwheel 
icon in the top right corner. Then in the drop-down menu select "Export". The selected elements will be exported to the 
folder we have selected on the computer. The extension of all such files is .environment. 
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4.8.2. Importing an environment package 

 With the "drag and drop" method, we can easily import the environment files into the program. We just have to drag the 
desired file to the program window from the computer's folder. A system message will appear informing us about the 
successful import. 

 The Import command can also be accessed from the Settings / Open and Save tab after selecting "Environment Package 
command. 
 
Of course, the environment package file that was saved in 2017 can also be imported into the 2018 version. If there are 
elements in this package that have the same name as an existing one, the program requests confirmation for overwriting. 
If this package contains styles, the program does not overwrite styles with the same name, but copies the non-conflicting 
files to the User category. After importing, the program must be restarted. 

4.9. Editing the 2D stair symbol 

You can change the appearance of the 2D symbol of the stairs to the schematic representation. In schematic mode, the 
components (lines, texts, etc.) are freely editable. 
 
As a result of this command, the representation of the staircase switches to schematic representation on the floorplan, 
which is a freely editable group. Entering the group, the stair components (lines, texts, etc.) are freely editable. Editing 
does not affect the 3D model. 

 

 
 

4.10. Restoring the 2D of the stair 

It is used to restore the original state of the stair symbol previously converted to an editable group. 
Restoring the original symbol also involves discarding all the changes made to the editable group. 

 

4.11. Styles directly available from the Property manager 

Property Manager changed: When you start an item creating command, a list of styles will appear on the left side of the 
interface and if you click on the style name, the selected style become active. The item you create next is made with the 
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properties of the new style. Thanks to this solution, you can quickly switch between styles, for example, when you draw a 
load-bearing wall, then a partition wall and then a load-bearing wall again. 
 

 
 
The style list that appears after the start of the command highlights the name of the active style. While drawing, you can 
click on a style name to continue with that style. 

4.12. Editing the front view profile of a curtain wall 

By clicking on the Ribbon Bar / Curtain Wall / Edit Layout command or on the endpoint marker on the floor plan, you can 
edit the front view profile of the curtain wall with which the current profile can be further edited. 
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4.13. Curtain wall division spacing  

When determining the horizontal and vertical spacing of the curtain wall divisions you can not only determine the interval 
of the divisions but you can determine the space between each of them that is more practical in many design situations. 

 

 
 

4.14. Virtual tour animation by capturing the walkthrough 

The animation can be made not only by defining points in the 2D window, but in the 3D window you can walk through the 
model and by clicking with the left mouse button you can define points through which the walkthrough will be completed. 
Using this option you do not need to define the points on which the camera focuses from that specific point, when clicking 
with the left mouse button the program will create the animation based on the view in the 3D window. After the last point 
has been placed, you can close the command with the right mouse button, after which the path of the animation becomes 
immediately visible on the floor plan. The command is available in the Ribbon Bar / View / Animation / Walk and Fly / 
Walk. 
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4.15. Heliodon: moving the direction of the Sun arbitrarily 

By clicking on the marker on the lower circle of Heliodon, graphical modification of the Sun direction automatically starts. 
You can determine the new direction with just one click. 
 

 

4.16. Changing the default settings of the program 

In the Settings under the "Open and Save" tab, you can save the current project settings as new default settings by using 
the “Make current project settings as default” option. 
 
For example, if you would like to work in millimeters instead of meters, first change the current settings to meters and then 
press the "Apply" button. After that meters will be the default unit setting for new projects. 
 

 

4.17. Drawing window header: window magnifier command  

You can also access the command to magnify the active window from the header of each drawing window. 

 

4.18. Multiplication of frame elements of frame wall structures 

When configuring the frame structure of frame wall structures, you can use the command here to create new column 
positions, top plate duplicates, and other similar structures that can be created by copying the original structural element. 
This allows complex, parametric frame construction to be created in accordance with the current structural objectives. 
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4.19. Creating roof shapes with a direct command 

You can create some specific roof shapes directly using the Roof shapes command. 
 

 

4.20. Status Bar: List of drawings 

The text list of drawings available in the project is also available by clicking on the icon in the Status bar. The documents 
below the horizontal line are the drawings that are currently hidden in the project. 
If you click on a drawing of the list, it becomes active and enlarged. 

 

4.21. Status Bar: Solar access and orientation commands 

The commands for solar access, shadow, and orientation is all available by clicking on the North symbol in the Status bar. 
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4.22. New 3D rotating, mirroring commands in the menus of the main axis 
markers 

The new rotating and mirroring commands make it easier to position the elements correctly. Geometric errors (eg.: upside 
down ceiling lights) which are frequently encountered in downloaded items can be corrected quickly with the new 
commands. 
 

 

4.23. PDF import selects the imported elements and applies the optimal 
zoom 

When importing PDFs, considerably different scale ratios (such as the loaded PDF files are much smaller than the current 
drawings) may make it difficult to recognize and locate a loaded file. With the new extension, the program automatically 
selects and places the loaded PDF elements in the center of the drawing window. 

4.24. Settings that have been deleted from the Options dialog:  

Integrating Project Navigator into the Design Center 
Right-click mode in the Toolbar 
Selector menu display enabling 

4.25. New external louvre dialog with 3D preview 

The new dialog with 3D preview makes it very easy to adjust the louvre and support structure. 
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4.26. Video card recognition terminated 

The video card recognition command is terminated, instead we recommend using the DXDIAG system application 
provided by the operating system. 

 
 


